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Keen to get to know TypeIt4Me? This user guide is your new best friend.

To get up and running as quickly as possible, dive straight in to the Quick Start section 
for a crash course in the basics of text expansion. Come back to consult the in-depth 
Reference section when you have specific questions.
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1. Quick Start 

1.1 - Opening the app

Go to your Applications folder and double click on TypeIt4Me. The 
first time it launches, you will be presented with a window titled 
“Please allow TypeIt4Me to control your computer” (pictured right).

Accessibility access needs to be enabled in order for TypeIt4Me to 
expand abbreviations as you type. Click OK to be taken directly to 
the Accessibility pane in System Preferences, then click the 
padlock and if prompted, enter your administrator password*. 
Finally, tick the checkbox next to TypeIt4Me and log out or 
restart your Mac for the setting to take effect. 

Please note: until you grant TypeIt4Me this accessibility permission,  
expansion will *not* work when you type your abbreviations with the keyboard.  
It will *only* work when you point and click on your abbreviations in the  
TypeIt4Me menu bar dropdown list.

*If you don’t know your password, this Apple support page may be of some help: http://support.apple.com/kb/ht1274  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1.2 - Getting acquainted with text expansion

TypeIt4Me is a text expander. Text expansion is essentially on-the-fly substitution of short  
typed abbreviations with longer ‘snippets’ of content, which can include lengthy words, phrases,  
boilerplate texts or even pictures. Whenever you type a pre-defined shorthand abbreviation of your  
choosing, TypeIt4Me instantly replaces it with its corresponding snippet. 

Once you’ve granted the necessary accessibility permission outlined in section 
1.1, launching TypeIt4Me will bring up the main window (pictured left). This is 
where you’ll customise the app to your liking and define your own personal 
shorthand. To give you some inspiration, we’ve included a few dummy 
abbreviations you can play with while you get to grips with how everything works. 
When you type these in any app that accepts text input, they’ll expand to common 
greetings, contact details and phrases - ‘snippets’ of text and / or images.

How about trying one of the examples out? With TypeIt4Me running, switch to 
your text editor of choice and type thxem. As soon as you type a space after it, 
this should instantly become: Thank you very much for your email.*

*If this doesn’t happen, it’s possible you didn’t grant TypeIt4Me the accessibility permission it 
requires for keyboard expansion, or you forgot to log out or reboot your Mac after doing so. Check 
the troubleshooting section at the end of this user guide.
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Still with us? Great. Text expansion is a fantastic time saver. Hopefully,  
you’ve enjoyed typing the examples and watching reams of text content  
magically materialise in the blink of an eye. If so, you’ll be pleased to learn  
the fun doesn’t stop there. 

In addition to expanding abbreviations typed on the keyboard, TypeIt4Me 
offers a handy point-and-click option. If, like us, you occasionally forget 
what abbreviation you assigned to a particular snippet, or even if you 
simply don’t feel like typing it, you can scroll through the TypeIt4Me menu 
bar list and click on it, as shown here (right). Doing so will insert the 
snippet contents wherever the cursor is currently positioned in the app 
you’re using.

All good so far? Congratulations, you’ve installed TypeIt4Me on your Mac 
and it’s working as intended. Feel free to try out some of the other pre-
defined abbreviations in the Examples set to get a feel for things before we 
move on. In the next section of this guide, we’ll look at ways to define your 
own abbreviation / snippet pair. 
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1.3 - Defining your first abbreviation / snippet pair

OK, we’ve had a play with the provided examples and explored the delights 
of text expansion, so by now you’re probably champing at the bit to start 
defining your own shorthand abbreviations. Let’s get down to business. 

1.3.1 Create a new snippet set

First, you’ll want to create your own snippets set, i.e. a file that will contain 
a new group of snippets. Do this by clicking the + button below the bottom 
left corner of the “Sets on this Mac” pane (pictured right). When prompted, 
give your new set a name (“My Snippets”, perhaps) and click Done. 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Once you’ve saved your newly created snippets set, you’ll see it appear in the 
list, underneath the bundled Examples set. You’ll notice it’s highlighted, which 
means it’s now the active set - that is, only snippets within this set will be 
expanded. Only one set can be active at any one time. You can easily switch 
between them by clicking once on the name of the set you want to activate. You 
don’t have to use multiple sets, the option is simply there for anyone who 
prefers to keep different snippet types in separate groups, for use in specific 
contexts.

Looking further down, you’ll see that the list of snippets is now empty save for 
one abb / snippet pair. This is a placeholder that is created by default. Try typing 
abb in your favourite word processor or in the body of an email (or just about 
anywhere else). As soon as you type a space* after it, the word abb (i.e. your 
abbreviation) will be replaced by the word snippet. 

*Later in this guide you’ll learn how to change the expansion ‘trigger’ from a space to an alternate 
punctuation key if that suits you better. You’ll also learn to fine tune your preferences to specify 
whether the character that triggered the expansion should be appended to the end of the 
expanded snippet or dropped.
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1.3.2 Define a new abbreviation via the main app window

Now that we’ve observed the snappy way TypeIt4Me expands abb to snippet,  
it’s time for you to redefine both abb and snippet to something more useful.  
If your name were Max Wolfeschlegelstein, you might - for example - want to type  
mxw and have that expand to Max Wolfeschlegelstein. Let’s try that, shall we?

1. First, double click on abb so that it becomes highlighted. This means it’s now editable.

2. Next, you need to overwrite abb by typing mxw in the abbreviation cell.
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3. Now press the TAB key to move to the adjacent snippet cell.

4. Overwrite snippet by typing Max Wolfeschlegelstein in the snippet cell.

5. Press the TAB key once more and you’re all done, your changes will be saved.

That was easy peasy, wasn’t it? You’ve just defined a new abbreviation / snippet pair  
without even breaking into a sweat. Now, every time you type mxw in a Mac app in which  
you can type, it will expand to Max Wolfeschlegelstein. Go ahead and create as many  
new abbreviation / snippet pairs as you need. Add new ones or delete existing ones  
using the + and - buttons at the bottom of the snippets list. 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Of course, the above steps are all well and good for defining short words, phrases  
and names, but what about when you want to take things to the next level? No problem.  
To define a particularly long snippet and / or include rich text or pictures, type or paste it  
into the full snippet content pane to the right of the snippets list, so you can more easily  
see what you’re doing. 

To add rich text or pictures, just remember to first select that option from the Contents 
dropdown menu (pictured right), then hit the Save button when you’re done.

1.3.3 Define a new abbreviation via the Add a Snippet shortcut

We’ve shown you one way to define a new abbreviation and you’ve grasped the nettle  
with gusto. But wouldn’t it be great if instead of doing it that way you could select some 
existing text, then create a snippet and its abbreviation without having to re-type it?
Good news: you can do exactly that. 

Imagine you are browsing in Safari and there’s some text in a web page discussing Steve  
Jobs’ myriad successes that you want to add to your collection of snippets. For instance, 
you may want to abbreviate “Apple Macintosh” and have it come up whenever you type Appl. 
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Start by highlighting and copying to the clipboard the text you want  
to abbreviate - in this case, Apple Macintosh (pictured).

…Next, pull down the TypeIt4Me menu and click on the 
Add a Snippet... option as shown below.
 

Page �  of �15 90



A window will come up prompting you to add a snippet with Appl as its 
abbreviation (pictured right). By default, TypeIt4Me uses the first four 
letters on the clipboard to suggest the abbreviation, but you are of 
course free to change this to something better / more memorable. Click 
the Add this Snippet button when you’re done editing. Just remember, if 
you want to add pictures, you’ll need to click the Rich text radio button 
(as illustrated below).

Pretty painless, all in all, no? You may want to consult page 78 of the 
Reference section to learn how to define a hot key for adding a snippet 
this way. It’ll save you reaching for the menu bar. Otherwise, you now 
know the basics of how to use TypeIt4Me. Feel free to get stuck in and 
come back to this guide later when you have specific questions or you 
want to learn how to craft more advanced snippets. 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2. Reference: What? Where? How? 

2.1 - What is TypeIt4me?

TypeIt4Me is a text expander. Text expansion is essentially on-the-fly substitution of short typed 
abbreviations with longer ‘snippets’ of content, which can include lengthy words, phrases, 
boilerplate texts or even pictures. Wherever you type a shorthand abbreviation of your choosing, 
TypeIt4Me will instantly replace it with a corresponding snippet that you’ve defined. 

The very first text expander developed for Mac OS, TypeIt4Me is an app designed to accelerate 
your typing by rapidly replacing your custom defined abbreviations with longer ‘snippets’ of text 
and / or pictures as you go. Once installed and launched, it silently runs in the background to help 
you type more quickly and accurately. 

Find yourself typing the same things over and over? Build up a set of abbreviations and the full 
text / image ‘snippets' that they represent. TypeIt4Me will save you time and keystrokes by 
automatically expanding them while you continue typing. This works systemwide, in any app in 
which you can type.
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2.2 - “How might I use TypeIt4Me?”

How you use TypeIt4Me will depend on who you are and what you often find yourself writing. It’s 
popular with doctors, transcriptionists, lawyers, customer support teams, coders, journalists, authors 
and bloggers. 

Things TypeIt4Me can help you knock out more quickly include:

• people’s names, email addresses and other contact details

• commonly repeated phrases

• awkwardly lengthy / difficult-to-spell medical terms 

• boilerplate clauses for legal contracts

• “Have you tried turning it off and on again?” IT support replies

It can be particularly useful for entering repetitive data in a database file or spreadsheet, or for 
anyone who finds him or herself frequently typing the same things over and over.

 
Many people find TypeIt4Me useful for speedily inserting the current date and a return address when 
composing letters. It’s handy for email sign-offs, too. For example, you might type just br to get: 
Best regards, 
Jon Appleseed.
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As developers, we use TypeIt4me ourselves to type standard phrases when providing email support 
for our software. It’s great for programming, too. Abbreviations don't have to be shorter than the text 
they type. For example, we’ve defined tilde (5 letters long) to 'expand' to a single character (~), which 
is often needed in C programs, yet always seems to disappear from the keyboard when it’s most 
needed.

TypeIt4Me can save you having to switch keyboards to type in other languages and use special 
characters, accents or symbols. For instance, a US keyboard may not have a readily accessible Euro 
symbol, so  eur could 'expand' to €. When typing in French, ag could become à (a with an accent 
grave). It’s much easier than typing alt-` + a. 

By defining a set of mnemonic abbreviations for most frequently used words, you can type speedily 
yet more accurately and with less effort. TypeIt4Me will save you keystrokes and potentially alleviate 
repetitive strain injury :)

For example, u r rh ab th cgs could instantly produce you are right about the changes (if you have 
defined u=you, r=are, rh=right, ab=about, th=the and cgs=changes). 
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2.3 - An overview of the main TypeIt4Me app window

The main app window comprises three core sections. The toolbar is where 
you’ll access preferences, print options and help (i.e. this user guide). You can 
also bring up statistics detailing approximately how much time TypeIt4Me has 
saved you. While you are using the app in fully functional demo mode, there 
is a registration button for when you’re ready to purchase and enter a licence 
code. That will go away once you’ve registered.

Below the toolbar is a shallow segment where you’ll create and manage your 
snippet “sets” - files containing your snippets and their corresponding 
abbreviations. This is divided into locally stored sets on the left and remote 
sets on the right (more on this later).

The deeper bottom segment is where you’ll create and edit your snippets. In the 
left half is a list of the snippets contained within the set you’re currently using. 
Select one and its contents will be displayed as a large editable preview in the 
large pane on the right. Beneath these panes are buttons and controls for 
adding, removing, editing, labelling and sorting your snippets, as well as an 
assortment of menus for controlling their individual behaviours and crafting 
more advanced expansion tricks. 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2.4 - How to create your own custom abbreviations

There are two ways to define an abbreviation and its corresponding ‘snippet’. The first involves selecting some 
text, then clicking on Add a Snippet… in the TypeIt4Me menu bar or pressing a hotkey you’ve assigned to that 
action. The second entails creating your abbreviation / snippet pair from scratch in the main TypeIt4Me app 
window. We’ll walk you through both methods.

2.4.1 First method: “Add a Snippet…”  

Suppose you often close your emails with the words Kind regards,. It’d be easy to remember the abbreviation  
kr as shorthand for Kind regards, wouldn't it? 

To add this entry to your TypeIt4Me snippets set: 

• type out Kind regards, one last time in your email  

• select the text and either cut or copy it to the clipboard (⌘-X or ⌘-C)

• click on Add a Snippet… in TypeIt4Me's menu - or press a hotkey you’ve assigned to this action in 
Preferences.

This will bring up a window in which you'll be prompted to define a custom abbreviation that will represent the 
new Kind regards, snippet that you’re about to create. 
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By default TypeIt4Me will initially suggest that you use the first four letters of the text in the clipboard as your 
abbreviation. While this will sometimes be apt, in this case we’d prefer the abbreviation to be kr, so just type that  
into the abbreviation field instead. Finally, click the “Add this Snippet” button to add it to the current active set.

…That’s it! From now on, every time you type kr TypeIt4Me will instantly 
backspace over the abbreviation (kr) and type the full text for you (Kind 
regards,).

Please note: if the text you copy to the clipboard is in rich text format 
(i.e. it contains font, style and colour information) and you want to 
preserve the formatting, you need to click the “Rich text” radio button. 
Doing so will save those RTF attributes when you click “Add this 
Snippet”. If you don’t, the snippet will be saved as plain text by default 
and lose any font, style and colour attributes. 

In case you are wondering, the Applescript checkbox is for power users 
who wish to define snippets that execute actions using Applescript 
(more on that later). Clicking the checkbox will insert the special symbol 
that will send the contents of the snippet to AppleScript for execution. 

Page �  of �22 90



2.4.2 Second method: “Edit Snippet…”

Now we’ll look at how to create a kr —> Kind regards, abbreviation / snippet pair from scratch 
in the main TypeIt4Me app window. Click on Edit Snippet… in the TypeIt4Me menu - or press 
a hotkey you’ve assigned to this action in Preferences.

The main TypeIt4Me app window will pop up. First, click the + button in 
the bottom left corner or type ⌘-N. A new default snippet will appear in 
the list with the abb cell highlighted ready for editing. Type your new kr 
abbreviation to replace the word abb. Press TAB to switch to the 
adjacent snippet cell. Finally, type Kind regards, then press TAB again.  
Voila! Your new abbreviation and snippet have been saved.
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 2.5 - How do I get something typed for me?

Once you’ve defined your own shorthand in TypeIt4Me, there are two ways of triggering automatic insertion 
of the text or image an abbreviation represents. The first  - usually the quickest and most fluid - involves 
tickling the keyboard, while the second is a mouse or trackpad affair. This is how it works:

2.5.1 Keystrokes (type your abbreviation)

Type your defined abbreviation, (optionally) followed by a trigger such as a space or punctuation. For 
example, type scf for supercalifragilisticexpialidocious, or adis for antidisestablishmentarianism. Typing re 
could produce Riccardo Ettore. That’s pretty much all there is to it.

In case you’re wondering, if we do define re as an abbreviation for Riccardo Ettore, TypeIt4Me will not 
interfere when we type more or read or area; it looks for the letters re as a separate word, i.e. preceded and 
followed by spaces or by punctuation marks of your choice. It’s worth noting, mind, that when defining 
abbreviations, it's best to avoid potential conflicts with existing words or acronyms. If the first name in the 
example above were Brian and not Riccardo, rather than choose be as the abbreviation it would be better to 
go with something unique like bre. 

If you ever do need to type a letter combo that’s been defined as an abbreviation without it expanding 
(perhaps "re your letter dated the 12th..."), pressing the shift key at the same time as the space bar will 
prevent the space from triggering expansion. So in our example above re wouldn’t become Riccardo Ettore. 
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2.5.2 Point-and-click (pick your abbreviation from the menu bar)

If you click on the TypeIt4Me icon in your 
Mac’s menu bar you’ll see that the resulting 
dropdown lists all of the abbreviations in your 
current active snippet set. Click on the one 
you want and the snippet will be inserted 
wherever the cursor is in the app you’re 
currently using.

This can be useful if, like us, you occasionally 
forget what abbreviation you assigned to a 
less frequently used snippet. Just scroll 
through the list to find it, click to insert it, then 
carry on typing.

Once you’ve defined an abbreviation, as long as TypeIt4Me is running in the background it will be available 
“on tap” at all times, anywhere text or images can be pasted. It’ll work in your word processor, paint program, 
Finder, Contacts, Safari or just about any app you like. Isn’t technological progress grand? Soon we’ll all be 
reclining in sun loungers drinking cocktails while the machines do everything for us. 

Page �  of �25 90



2.6 - What are snippet “sets”? How might I use them?

In TypeIt4Me, a snippet “set” is a file that contains a group of TypeIt4Me snippets. These sets 
are a way for you to organise and keep different groups or types of snippets separate, if you’re 
so inclined. You can have as few or as many sets as you like. You could use just a single set 
containing all of your snippets, or you could switch between several different sets, each suited 
to a particular context. 

Your available sets are listed at the top of the main TypeIt4Me app window, with the currently 
active one highlighted. We start you off with an Examples set to give you some inspiration and 
provide some sample snippets to play with. You’ll probably want to create your own in which 
you’ll save the new snippets you define. Here are a few examples of how you might use sets:

• Switch between an “Office set” and a “Home set”.  

• Maintain a secondary “Spanish snippets” set for when you’re typing in that language. 

• Keep a separate “Code snippets” set that you only use when you’re programming.
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By design, only one set can be active at a time; this is to prevent conflicts in cases where you 
might want the same abbreviation to expand to something different depending on which set 
you’re using. For instance, you might have a nec abbreviation that expands to necessity when 
your “English snippets” set is active and to necesidad when “Spanish snippets” is active. 

In the Mac Finder snippet sets appear as files with the extension “.typeit4me”. They’re stored 
in a Sets folder in TypeIt4Me’s Application Support folder within your User Library. If you have 
a snippet set somewhere else on your Mac (e.g. someone emailed you one to use), double-
clicking it will automatically move it to the Sets folder and activate it.

You can quickly and easily switch between 
sets by clicking on the one you want in the 
TypeIt4Me menu bar (pictured left) or by 
selecting it in the list at the top of the main 
TypeIt4Me app window.
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2.6.1 Create a new snippet set

Let’s take a look at how to create your own snippets set. It’s easy. 
All you have to do is click the + button below the bottom left corner 
of the ‘Sets on this Mac’ pane (pictured right). When prompted, 
give your new set a name (“My Snippets”, perhaps) and click Done. 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Once you’ve saved your newly created snippets set, you’ll see it appear in the 
list, alongside the bundled Examples set. You’ll notice it’s highlighted, which 
means it’s now the active set - that is, only snippets within this set will be 
expanded. 

Remember, only one set can be active at any one time, but you can easily switch 
between them by clicking once on the name of the set you want to activate. 
Again, you don’t have to use multiple sets if you don’t want to, it’s entirely up to 
you. The option is simply there for anyone who prefers to keep different snippet 
types in separate groups, for use in specific contexts.

…It probably hasn’t escaped your attention that there are two panes for sets and 
that the one on the right is headed “Remote sets”. This is a much requested 
feature previously only available in the Mac App Store version for use with iCloud. 
TypeIt4Me version 5.5 now leverages network connectivity and cloud storage 
services to enable you to use the same snippets on multiple Macs and keep them 
in sync. We’ll explain this further in section 2.6.2. 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2.6.2 Sync snippets via iCloud Drive, Dropbox or Google Drive

In Preferences you can enable iCloud Drive, Dropbox, Google Drive or a shared network folder in 
which to store your snippet sets. Doing so enables you to use the same snippet(s) on multiple 
Macs and keep those snippets in sync across all your machines even as you add new ones. 
Enabling remote sets and specifying which sync service or shared network folder you’d like to use 
is explained on page 79. 

When you enable a cloud sync service or specify a shared network folder to use, it’s activated in 
the pane to the right of “Sets on this Mac”. You can then create new sets in your remote folder 
using the + button or move existing local sets to it by dragging them across (pictured below). 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preferred cloud sync or shared network folder, just drag it across.

2. Your snippet set will now be shared with any other Macs you have 
set up to use the same sync option in TypeIt4Me.



2.7 - Where and when does TypeIt4Me type?

Technically, the “typing” that TypeIt4Me performs when it expands one of your abbreviations is 
actually a “paste” operation. It will occur wherever you are currently entering text, be it in a word 
processing document, an email message, a save dialog, a folder or file name field, a database 
entry field and so on. 

A snippet - which can be text and / or picture(s) - will be pasted wherever the cursor is currently 
positioned when you do one of the following things:

• you use your mouse or trackpad to “pick” it from a list in TypeIt4Me's point-and-click menu

• you type the abbreviation associated with the snippet (optionally) followed by any of up to 35 
potential trigger characters. The default trigger is a space.

If you go to the Triggers tab in TypeIt4Me’s preferences, you can define exactly what characters 
should act as triggers. You can also choose to have no triggers, in which case your abbreviations 
will expand as soon as you type them. 

When expanded, snippets that were defined and saved as plain text will match the font and style 
of any text immediately preceding the point at which you insert them. “Only “rich text” snippets will 
preserve the formatting with which they were originally saved, wherever you expand them.

Page �  of �31 90



2.7.1 Compatibility issues with other third party software  

TypeIt4Me works with the vast majority of third party applications that accept text input. That said, 
while it’s rare, conflicts can occasionally arise. The automatic “typing" of your snippets is achieved 
by temporarily placing the snippet contents on the Clipboard and issuing a Paste command. 
Some apps are built in such a way that they can’t handle pasting in certain text fields and this can 
prevent TypeIt4Me from doing its job.

If TypeIt4Me ever appears to fail, try doing a "manual" paste (cmd-v) into the text field in which 
you’re typing and see if that works. If it doesn't, then the developer of the software in question has 
built it in such a way that it will prevent TypeIt4Me from working. This is the case in Entourage, to 
cite one example. You cannot expand an abbreviation in the save dialog that follows Save as PDF 
in Entourage’s Print dialog. Meanwhile, the same operation works fine in Apple’s TextEdit and 
Mail. If you run into a frustrating issue like this and consider it a deal-breaker, your best bet for 
resolving it is to contact the developer of the software you’re using and request that they support 
pasting into the field in question, so that it will play well with TypeIt4Me.

2.7.2 A note on password entry and secure input fields

Some password entry fields are protected against programs trying to "sniff" what you type into 
them and this can prevent TypeIt4Me from working. For example, entering a TypeIt4Me 
abbreviation in a password field in Safari will not result in expansion of the snippet. All things 
considered, given today’s increasingly risky digital security landscape, this is A Good Thing - we 
wouldn’t encourage you to store sensitive passwords as unencrypted, plain text snippets. 
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It’s far more secure to use Safari’s keychain or a dedicated third party password manager app to 
handle your online logins, as these can offer a sophisticated level of protection. However, if you 
really want to - perhaps you have a low-risk ‘throwaway’ account you frequently log in to and 
you’re not concerned about it potentially being compromised - you can use TypeIt4Me to enter 
passwords for you. 

Entering passwords with TypeIt4Me

Just define an abbreviation, e.g. pw, and define the snippet as 
username⇥password⏎%- using the Insert > Special menu 
to insert the TAB, carriage return and Don’t Append Triggers 
symbols. On a login page in Safari, typing the abbreviation 
and expansion trigger into the username field will submit your 
login details for you. 

Secure input can prevent TypeIt4Me from working

Secure Input is a very useful protective feature built into many apps that kicks in to shield your 
passwords and other sensitive data while these are being entered. This is so that they can't be 
intercepted and recorded for nefarious purposes and only you will know what you're typing. 
Secure Input is very much a good thing, however it is meant to be used sparingly. It can cause 
problems if it isn't turned off again once it's done its job. 
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In some apps, when the Secure Input protection is triggered it erroneously remains enabled even 
after you're done entering the sensitive information and / or you switch to a different app. 
TypeIt4Me and other text expansion apps will then effectively be 'locked out' of keyboard input 
and prevented from functioning until Secure Input is turned off.

How to resolve the Secure Input issue and get TypeIt4Me working again

If Secure Input stops TypeIt4Me from working you'll need to identify the app that has left Secure 
Input enabled and quit that app. Doing so will enable TypeIt4Me to resume expanding your 
abbreviations as normal again.

It's often a web browser such as Google Chrome or Firefox that leaves Secure Input enabled, 
though there are known issues with other apps too, including popular password managers such 
as 1Password and Lastpass. If none of those looks to be responsible, it could also be down to 
other third party apps like Fluid, Hulu Desktop, iFinance, Quicken Scheduler, Chronories or 
Notational Velocity. If you're a command-line tinkerer you might also want to ensure that 
Terminal's 'Secure Keyboard Entry' is turned off when you're done entering a password.
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2.8 - How do I stop TypeIt4Me from typing stuff for me?

Sometimes you may want to stop TypeIt4Me from doing its thing, for one reason or another. Of 
course, you could quit TypeIt4Me altogether, but you may find it more convenient to leave it 
running and just selectively stop it expanding abbreviations. There are a few ways to do this. 

2.8.1 One-off keyboard expansion blocking

The default trigger for expanding an abbreviation is typing a space after it. If ever you want to type 
an abbreviation as part of a sentence without TypeIt4Me expanding it, all you need to remember 
is to hold down the shift key as you type the space after it. Doing so will prevent expansion.

2.8.2 Temporarily pause TypeIt4Me

If you want to type continuously for a few minutes 
without any interference by TypeIt4Me, you can 
temporarily pause automatic expansion of typed 
abbreviations. To do this, select the Pause option 
in the TypeIt4Me menu. A small " symbol on the 
TypeIt4Me icon in the menu bar will denote that 
the app is in pause mode. 
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When you’re ready for TypeIt4Me to carry on 
expanding your abbreviations as normal, just 
select the Resume option.

2.8.3 Disable keyboard expansion indefinitely

If you’re after a longer term solution that switches typing expansion off 
indefinitely - even across system restarts - you may wish to check the 
“Disable keyboard expansion” box in TypeIt4Me’s Preferences. To find 
this, click on Preferences and navigate to the Expansion tab. It’s the first 
option in the list on the left.

While this box is checked in Preferences, nothing you type will ever 
be expanded. However, you’ll still be able to use the point-and-click 
menu list to insert snippets, should you need them. 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2.8.4 Disable TypeIt4Me expansion on a per-app basis

There may be certain apps in which you never want expansion to 
occur. To that end, you can selectively disable TypeIt4Me on a 
per-app basis. 

All you need to do is go to TypeIt4Me’s Preferences, navigate to 
the Apps tab and add those apps you’d like to exclude from 
expansion to the list of apps that require special behaviour. Just 
click the + button at bottom left and select an app to add to the 
list. You’ll see that the default special behaviour is to not expand 
snippets, so you can leave that as it is.

Once you’ve added the app(s) you’d like to exclude just click 
Done and from that point on, TypeIt4Me won’t expand any of 
your snippets when you’re working in that particular application. 

If you later change your mind, just return to the Apps tab in 
Preferences, click the app in the list to select it, then use the - 
button at bottom left to remove it.  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2.9 - How to include pictures and / or styled text in snippets

It’s likely you’ll mainly be using TypeIt4Me to expand abbreviations to long words and phrases, 
but in addition to text, snippets can include pictures. To have a picture in your snippet, you just 
need to change the contents type from Plain text to Rich text/pictures:

Once you’ve done that, you’ll be able to drag & drop 
or paste pictures in the most common formats (gif, 
jpeg, png, tiff, etc). 

Note that when you select Rich text/pictures, you 
can also apply formatting attributes to your text, such 
as font, colour, bolding, italics, underline and so on. 
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When Rich text/pictures is selected, you’ll notice that the Format menu will become enabled, as 
pictured here. TypeIt4Me offers considerable flexibility when it comes to formatting your snippets. 
Have a play around with the various options. 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2.10 - How to limit an abbreviation to a specific app

Sometimes, you may wish to specify that an abbreviation should only expand in one specific 
app. To do this, just click the icon in the “App” column to the left of the abbreviation; this will 
open a menu in which you can select the app to which you’d like to confine the abbreviation.

Say for instance we want the abbreviation ds to expand to Dear Sir, but only ever in the Apple 
Mail app and nowhere else. In order to specify that, we’d do the following:
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1. Click the app 
icon to the left of 
the ds abbreviation
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2. Double click on the 
Mail app in the popup 
dialogue to associate it 
with the abbreviation



Once you’ve done that, you’ll notice the previously generic app icon (that denotes an 
abbreviation will expand in all apps) has been replaced with the Apple Mail icon. This 
means the abbreviation will now only expand when typed in that particular app.

To clear an association, just click once on the 
app icon to the left of an abbreviation and 
confirm your choice when prompted.
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2.11 - Labelling snippets

Snippets can optionally be assigned labels to help you identify them in the 
TypeIt4Me menu. If you only ever use typed-at-the-keyboard expansion you 
may not want to bother with it, but it can be a useful feature if you do find 
yourself manually picking snippets from the menu.

For example, you might have two phone numbers: one for personal calls 
and the other for office-related matters. Instead of showing up in the menu 
as two confusingly similar multi-digit numbers, they could appear as clearly 
distinguishable work and personal numbers. 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For each snippet, type a memorable 
descriptor in the label field (in the bottom right 
corner of the main app window, between the 
Contents and Insert menus).

…Two clearly labelled 
phone number snippets

Two similar phone 
numbers with no labels…



2.12 - Displaying snippets in the TypeIt4Me menu

Let’s take a look at the point-and-click menu TypeIt4Me offers as an alternative to 
expanding abbreviations as they’re typed. By default, this lists all the snippets in the 
currently active set, showing both the abbreviations and the labels (if you have 
labelled them). You can change this and assign different behaviours to individual 
snippets. It’s possible to display none, some or all of your abbreviations in the menu, 
setting each one to show just the snippet, just the label, both or nothing at all.

To change the way a snippet is displayed in the TypeIt4Me menu, bring up the main 
app window and click on it once in the list of snippets to select it, then pick the option 
you want from the ‘Behaviour in menu’ pulldown in the bottom left corner.

Page �  of �44 90

Use this pulldown to specify how 
you want your snippet to be 
displayed in the menu.



Please note: while you can control the way individual 
snippets are displayed in the menu, this behaviour does 
not override the general menu settings in Preferences, 
which have priority. If, for example, you specify that an 
individual snippet’s behaviour should be to show its label 
in the menu, the label will *not* be displayed if in the 
general menu Preferences you have selected the “Abbs 
only” or “No abbs, no (label), no snippets” options. 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Selecting a snippet, giving it a 
label and picking the ‘Show label’ 
option from this pulldown…

…will give you this result in the 
point-and-click menu



2.13 - Sorting and searching abbreviations and snippets

Over time, you may build a substantial library of shorthand abbreviations. It’s not uncommon for 
TypeIt4Me sets to contain thousands of snippets. This could grow problematic to manage if it 
weren’t for…the humble sort button and its stalwart partner the search filter. These two controls 
can be invaluable for taming large snippet libraries. Between them, they can help you to zero in 
and find specific snippets you may be looking to edit or remove.

2.13.1 Ways you can sort

Snippets can be sorted using any of the following criteria:

• Abbreviation (alphabetical or reverse alphabetical order) 

• Snippet (alphabetical or reverse alphabetical order) 

• Custom (drag individual snippets into your preferred order) 

• Date created (newest at the top) 

• Date modified (most recently modified at the top) 

• Date last used (most recently expanded abbreviations at the top) 

• Use frequency (most frequently used snippets at the top) 

• Label (alphabetical order) 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When you select “Sort by abbreviation” or “Sort by snippet”, the relevant column header will 
display an upward arrow ( ^ ) indicating the alphabetical sort order, with symbols at the top, 
followed by numbers and finally the letters A through Z. To reverse the sort order, click once on 
the column header. The upward arrow will change to a downward arrow to reflect the order.

2.13.2 Search your abbreviations and snippets by sorting

Looking for a specific snippet? When the snippets list is alphabetically sorted by snippet, typing a 
few letters will scroll the list to the first snippet that starts with those letters. When sorted by any 
other criteria, the list will scroll to reveal the first abbreviation that starts with the letters you type. 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2.13.3 Search your abbreviations and snippets by filtering

Type one or more letters into the filter field and the list of snippets will shrink to show only snippets 
that contain the combination of letters you typed - anywhere in the abbreviation or the snippet 
contents. As shown here, with the bundled Examples set active typing the letters em into the filter 
narrows the list down to three snippet results. The first and last results in the list contain the letters 
em in their abbreviations (eml and thxem), while the middle result - a latin dummy copy snippet -  
appears because in the contents of the snippet the letters em are found in the latin word Lorem. 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2.14 - “What does this Insert menu do?”

The insert menu enables you to craft more sophisticated snippets. These might produce fill-in-the-
blanks placeholder ‘prompts’ when expanded or perhaps use arithmetical formulae to expand to 
dynamically generated, context-aware snippets. You can do things like automatically insert a date 
that’s two weeks from now without having to work out what it will be. You can also embed special 
characters, nest snippets or even execute complex Applescripts when you type an abbreviation.

2.14.1 Insert the current date

Let’s look at how you might go about inserting the current date. Click on Edit Snippet… in the 
TypeIt4Me menu to bring up the main app window and click on the + ("add") button underneath the 
list of snippets. A fresh abb / snippet entry appears at the bottom of the list, with abb ready to be 
typed over by a name of your choosing that you will assign to this new abbreviation. 

Type a name for the new abbreviation. For this 
example, dtl will stand for date in long format. 
We’re going to make that expand to the current 
date, e.g. Friday, November 20, 2015. 
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When you’ve typed the name for your abbreviation, press the TAB key twice: the first press to 
move to the snippet field, the second to move to the large snippet editing pane to the right of the 
snippets list. 

Next, delete the word snippet. We’re going to replace it with a special syntax that will represent the 
current date in whichever format you like. Click on the Insert popup menu under the pane and select 
the desired date format. 
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Once you’ve selected a date format, you will see a funny looking mix of % signs and letters or 
numbers, for example: %A, %B %e, %Y 

This is a standard way to describe the elements making up date and time, called strftime. We won’t 
go into detail about it here; there is a wealth of information about strftime on the web, if you’re 
curious. What’s important is you can use the above Date and Time menus to pick pre-defined formats 
or you can roll your own using the individual elements in the lower three sections. You can get very 
granular and choose whether to display a leading zero in the month and / or day.

That’s pretty much all there is to it. No more scratching your head trying to remember what day it is, 
fumbling for a calendar or painstakingly typing out the current date. Just rattle off a quick dtl (or other 
abbreviation of your choice) and TypeIt4Me will take care of the rest, spitting out Friday, November 
20, 2015 (for example) in the blink of an eye.
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2.14.2 Insert the current time

To insert the current time, we follow the same initial steps outlined in section 2.14.1 that covers 
inserting the current date. Click on Edit Snippet… in the TypeIt4Me menu to bring up the main app 
window and click on the + ("add") button underneath the list of snippets. A fresh abb / snippet entry 
appears at the bottom of the list, with abb ready to be typed over by a name of your choosing that you 
will assign to this new abbreviation. 

Type a name for the new abbreviation. For this example, ctm will stand for current time. We’re going 
to make that expand to the current time, e.g. 18:04.

When you’ve typed the name for your abbreviation, press the TAB key twice: the first press to 
move to the snippet field, the second to move to the large snippet editing pane to the right of the 
snippets list. 
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Next, delete the word snippet. We’re going to replace it with a special syntax that will represent 
the current time in whichever format you like. Click on the Insert popup menu under the pane and 
select the desired time format. 
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Once you’ve selected a time format, you will see a funny looking mix of % signs and letters or 
numbers, for example: %H:%M 

This is a way of describing the elements making up date and time, called strftime. We won’t go 
into detail about it here; there is a wealth of information about strftime on the web, if you’re 
curious. What’s important is you can use the Time menu to pick pre-defined formats or you can 
roll your own using the individual elements in the lower three sections. You can be very granular 
and choose whether to display leading zeroes before single-digit hours or minutes.

That’s effectively it. Just rattle off a quick ctm (or other abbreviation of your choice) and TypeIt4Me 
will take care of the rest, spitting out 18:04 (for example) in the blink of an eye.
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2.14.3 Date and time mathematics

In addition to inserting the current date and time, TypeIt4Me offers date and time mathematics. You 
can set up formulae that will calculate a past or future date for you in relation to the present and 
produce that dynamically upon expansion. For example, you might wish to create a ‘due date’ 
abbreviation that expands to Please submit your feedback by [a date exactly 3 months from now].

To create that snippet asking people to submit feedback by a due date exactly 3 months away, 
start off the usual way, defining an abbreviation (sfdd perhaps) that expands to Please submit 
your feedback by. Then, with the cursor placed at the end of that phrase, click the Insert menu 
and pick the Date option, selecting the format you’d like.
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Your snippet should now look something like this:  Please submit your feedback by %A, %B %e, %Y
The string of percentage signs and letters tells TypeIt4Me what date format to use when it calculates 
and outputs the date during expansion. 

Next, it’s time to concoct a formula. In the Insert menu, pick the Date / Time 
Math… option. A window will appear that shows the current date and time. 
Underneath that, there will be a number of ‘stepper’ buttons that correspond to 
days (DD), months (MM), years (YY), hours (HH) and minutes (MM). These are for 
specifying how far in the past or future the dynamically generated date should be. 

Click on the upward arrow part of the MM 
stepper button three times to add three 
months to the current date (the resulting 
date in relation to the present will be 
displayed above, on the right). When 
you’re done, click OK. This will insert a 
formula in your snippet that will output a 
date exactly three months in the future 
every time the snippet is expanded. Click 
the Save button and you’re done.
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With the date and time mathematical formula added, your snippet will look something like this: 
Please submit your feedback by %A, %B%e, %Y@@@7862400.000000

In this example, now every time you type the abbreviation sfdd TypeIt4Me will expand it to 
Please submit your feedback by [Day, Month Date, Year], dynamically calculating the last part 
upon expansion to produce a date exactly 3 months hence. So if today is Saturday, December 5, 
2015, typing sfdd will produce Please submit your feedback by Saturday, March 5, 2016.

Now you know how it’s done, you may wish to practice repeating the process and use more of the 
stepper buttons to construct more complex formulae and create abbreviations that will expand to 
various different dates and times of your choosing. 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2.14.4 Embed special characters

You can use the Insert > Special menu (pictured right) to embed certain characters in 
expanded text (but only when the cursor is blinking in the large right-hand pane, not in the cell 
in the Snippet column). These are: 

• a special syntax (%| ) to tell TypeIt4Me where to position the cursor after 
expansion. For example: b could be defined as <b>%|</b>%- and would 
expand to <b></b> with the cursor placed between the html tags, ready 
for you to type the text to be tagged as bold in a web page you are 
editing.

Notice the use of %| to move the cursor left between the begin/end html 
tags and the use of %- at the end of the expanded text to tell TypeIt4Me 
*not* to add the trigger after expanding the abbreviation or else it would 
come out as <b> </b>, with a space (or whatever your chosen trigger) 
just after the <b> tag. 

• a special symbol (⌫) to represent a backspace (e.g. if you define g to 
type <backspace>ing you'll be able to stick the ing ending to any 
previously typed verb, saving you a keystroke) 

• a special symbol (⇥) to represent a TAB that will be typed separately 
from the rest of the snippet (very useful to create snippets that fill two or 
more tab-separated fields or cells) 
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• a special symbol (⏎) to represent a Carriage Return (also called Enter) that will be typed 

separately from the rest of the snippet (very useful to "press" the Send, OK or Login button 
when filling in forms) 

• a special symbol (⌘) to tell TypeIt4Me to insert the current contents of the clipboard at 
that position (NB if you ever need to have the ⌘ symbol actually appear in the expanded 
text, insert 2 of them next to each other: ⌘⌘) 

• a special symbol (℁) which will cause TypeIt4Me to send the entire text of the snippet to 
AppleScript for execution.  
 
Note: if the text is not a valid AppleScript script, expanding the abbreviation will return an 
error. It is up to you to ensure the AppleScript is valid, as TypeIt4Me performs no checks 

• a special syntax (%+) to tell TypeIt4Me that it *must* append the trigger that caused the 
abbreviation to expand. This is useful for overriding the general Preferences setting for the 
Append/Don't Append Trigger on an abbreviation by abbreviation basis. 

• a special syntax (%-) to tell TypeIt4Me *not* to append the trigger that caused the 
abbreviation to expand. Again, this is handy if you want to override the general 
Preferences setting for the Append/Don't Append Trigger on an abbreviation by 
abbreviation basis. 
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• a special syntax (✄autocue ) to tell TypeIt4Me to display the text between the scissors 
and hourglass as a cue and then wait until you press Tab. We’ll explain Autocue in more 
detail later.  
 

2.14.5 Set up Autocue templates

Autocue is a great time-saving feature that’s popular with power users. It enables you to set 
up templates containing placeholder prompts ("cues") for you to replace with corresponding 
text or data when a particular abbreviation is expanded. 

To include an autocue within a snippet, position the cursor in the 
large snippet content editing pane where you want it to start, then 
use the Insert > Special menu to insert an autocue. It will appear 
like this: ✄autocue⌛ . Just replace the word autocue with whatever 
you would like the prompt to say during expansion and you’re done. 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Let’s look at a hypothetical example of how a doctor writing a letter might use Autocue for 
quickly entering a patient’s details in a standard format. S/he could have defined an 
abbreviation, e.g. pdet, that expands to a snippet spread over several lines, with autocues 
inserted to prompt for the patient’s name, date of birth, height and so on.

The abbreviation will expand in stages, with each autocue prompting the doctor and waiting 
for input before proceeding to the next line. So when s/he types pdet TypeIt4Me will begin by 
typing the first line, with the name autocue prompt highlighted ready to be replaced by the 
patient’s name:
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Our doctor types the patient’s name, then presses TAB to continue. TypeIt4Me expands the 
next part of the snippet and prompts for the patient’s date of birth in dd/ mm/ yyyy format*. All 
the doctor has to do is continue the process, entering details and pressing TAB to progress to 
the end, at which point the expansion is complete.

* By default, when creating date Autocue prompts TypeIt4Me inserts forward 
slashes between the day, month and year. If you prefer dashes, just go into the 
snippet editing pane and change the slashes to dashes, then hit the Save button.

So, when you want to use Autocue, just remember that when you type your chosen 
abbreviation TypeIt4Me will expand the text up to the first hourglass symbol, highlight the 
“cue” (the word between the scissors and hourglass symbols) and wait for your input. You’ll 
type the content to replace it and then press TAB to tell TypeIt4Me you’re ready to proceed to 
the next part - if there is one. Just repeat as necessary until you’re done. 

Note: while TypeIt4Me is awaiting your input during an Autocue expansion, you can’t expand 
other abbreviations. Don’t panic, though: you can always exit ‘autocue mode’ and cancel the 
expansion in progress at any time by pressing the esc key twice.
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2.14.6 Nest your snippets 

Using the Snippets submenu, you can embed or “nest” other snippets to appear (expanded of 
course) within the expanded text of any given snippet. Just pick it from the list and it will be 
inserted wherever you’ve positioned the cursor in the snippet you’re editing.

Where they’re inserted in other snippets, in 
the editing pane nested snippets look like this: 
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2.14.7 Execute Applescript

If you know how to use AppleScript, you can use 
TypeIt4Me to execute a script when you type a shortcut. 
Just create a new abb / snippet pair and type or paste 
your AppleScript code into the snippet editing pane*. 
Then pull down the Insert > Special menu and pick 
Execute as AppleScript. 

This will place the special symbol ℁ at the beginning of 
the snippet, instructing TypeIt4Me to pass your snippet 
along to AppleScript for execution instead of inserting it.

For example, you could specify that typing om should open Mail 
and have the built-in OS X voice Zarvox say "opening Mail":

*Note: take care with inverted commas. These must be straight ("), not curly (“),  
or you will get an error when your Mac attempts to execute the Applescript. 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2.15 - Preferences

Many of TypeIt4Me’s features can be customised to suit your own personal requirements. You can 
tweak them to your heart’s content via the Preferences section. Don’t want spaces to trigger 
expansion? Looking to disable it completely in certain apps? This is where you’ll do it.

Along the top of the Preferences section you’ll find three ever-present global app setting controls: 
checkboxes with which you can specify whether you want TypeIt4Me to launch on login and 
whether it should display its app icon in the dock and / or menu bar. 

The rest of the app’s preferences are organised under seven tabs:
Triggers - Menu - Expansion - AutoCorrect - Apps - HotKeys - Sync
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2.15.1 Triggers

Under the Triggers tab you’ll find a set of checkboxes you can use to choose one, several or even 
all of 35 different keyboard characters that will act as triggers and cause your abbreviations to be 
expanded as you type. To add or remove a trigger, just tick or untick the checkbox next to it.

This picture shows the default setting, which is that typing a TAB or 
space will trigger expansion. Use the All or None buttons to quickly 
select or deselect all check boxes. 

If you select None, abbreviations will expand without the need to 
type a trigger. While some users have requested this feature, 
should you elect to go with this setting you will need to ensure that 
no two abbreviations start with the same letters. Otherwise, the 
shorter one will trigger as soon as you type it. 

You can choose to have the trigger appended or discarded, either 
as a global setting or on an abbreviation by abbreviation basis. 
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2.15.2 Menu

Click the second tab in Preferences if you want to tweak the TypeIt4Me menu. This is 
where you specify global settings to apply to the point-and-click list of snippets and control 
how snippets should be displayed - if at all. See the next page for more detail. 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Menu preferences determine how your snippets 
will be displayed in the TypeIt4Me menu (above)
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Important note: menu preferences 
that you set here may in some cases 
override behaviours assigned to 
individual snippets in the main editing 
window. For instance, when defining a 
snippet you may have set it to show its 
label in the menu list - but if in Menu 
Preferences you’ve selected “Abbs 
only”, that’s what you’ll get.

Abbs only
This will list just your abbreviations, 
with no accompanying label or 
snippet contents. Hovering over an 
abbreviation will always reveal a 
tooltip containing the full snippet 
contents, however.

Abb → (label) and/or start of snippets
This is the default setting. Your abbreviations 
are listed with their accompanying labels (if 
you labelled them) and the first few 
characters of the snippet contents. Exactly 
what you see will depend on the snippet’s 
individual “Behaviour in menu” setting.

No abbs, no (label), no snippets
Select this option if you’d prefer to completely 
hide the point-and-click snippet list.

Enable point-and-click for all snippet sets
By default, point-and-click is limited to a list of the 
snippets in the current active snippet set. If you 
check this box, an extra Snippets menu item will 
be added, enabling you to browse *all* snippets in 
all sets and insert them by clicking.

Sort snippet by
This enables you to sort snippets 
alphabetically by the first letter of 
their abbreviation or expanded text. 
Alternatively, if you’ve dragged your 
snippets into a custom order in the 
main editing window, enable the 
Custom option here to reflect that 
order in the menu, too.

(label) and/or start of snippets
This won’t display your abbreviations, just 
the labels assigned to your snippets (if you 
have labelled them) and / or the first few 
characters of snippet content will be shown.



2.15.3 Expansion

Go to the third preferences tab if you want to tinker with settings that govern how TypeIt4Me 
behaves when expanding your snippets. There are eleven checkbox options from which to 
choose. We’ll give you a rundown of what each one does.

Disable keyboard expansion
This is fairly self-explanatory. If you check this box, TypeIt4Me will no 
longer expand your abbreviations automatically as you type. You’ll only 
be able to expand abbreviations using the point-and-click menu list.

Don’t append trigger
You should check this if you don’t want the character that triggers 
expansion to be added to the end of expanded snippets.

Case sensitive expansion
If you check this option you will have to type your abbreviations in 
exactly the same upper and / or lower case format in which they were 
defined or they won’t be expanded. Note that TypeIt4Me will still alert 
you if you attempt to define two identical abbreviations, even if you 
type them in a different case. So, if “ty” already exists, TypeIt4Me will 
intervene to remind you if you later try to define a “TY” abbreviation.
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Don’t match Abb Case
By default, if you type an abbreviation starting with a Capital letter 
or in ALL CAPS then TypeIt4Me will expand the snippet accordingly, 
so that it starts with a Capital letter or is typed in ALL CAPS. If you 
check it, the “Don’t match Abb Case” option stops that from 
happening.

Strip ’s’ for plurals
The “strip ’s’ for plurals” setting enables you to define an 
abbreviation only once to cover both singular and plural forms. If 
you check this option, typing an abbreviation and adding an s to 
the end before triggering it will result in the expanded snippet also 
having an s at the end. 

Suppose you define abb as abbreviation. Without this option, you 
would also have to define abbs to produce abbreviations. Either 
that, or you would have to type abb, then a space to trigger the 
expansion to abbreviation, then a backspace and finally type an s 
at the end of abbreviation. Instead, if you choose to strip s for 
plurals, you’ll be able to type abbs and see it expand to 
abbreviations, without the need to define abbs separately.
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Play sound on expansion
Select this option if you’d like to hear a system alert sound every time you trigger an expansion. 
When the checkbox is ticked, a list of available sounds will appear for you to choose from. Power 
users with lots of abbreviations may be driven crazy by constant beeping, but if you only use text 
expansion sparingly and tend to look at the keyboard rather than the screen while typing, it can be 
useful for alerting you to typos triggering unintentional expansion, for example.

Don’t restore Clipboard
Very rarely, you may run into an issue which causes TypeIt4Me to 
misbehave and consistently produce the contents of the clipboard 
instead of the snippet corresponding to the abbreviation you typed. It 
can happen on older, slower Macs or when many apps are open, 
causing event handling to slow down. Selecting the “Don’t restore 
Clipboard” option will prevent this and ensure you always get the right 
snippet expansion. We don’t recommend using this feature unless you 
have to, however, because it does mean every time you expand an 
abbreviation you’ll lose anything that was copied to the clipboard.

Hilite abb to replace
Tick this checkbox if when you undo (cmd-z) an expansion you’d 
prefer to see the abbreviation you typed come back, highlighted and 
ready to be replaced with something else.
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No DOuble CAps 
This will prevent you from typing two or more consecutive letters in 
uppercase. If you turn this option on, you will have to press the 
capslock key to type OK, US, USA, NASA, etc. Backspacing over a 
letter that has been turned to lowercase will allow you to re-type it in 
uppercase. 

Capitalize new sentence. 
Turning this on will automatically turn the first letter you type after 
pressing return to uppercase. Ditto for letters typed after a . ! or ? but 
only when they are followed by a space. Note: when typing the first 
letter in a new document, it will not be capitalized because TypeIt4Me 
can only do so when it “watches” you type punctuation, as explained. 
This is not a bug, but a normal feature constraint. 

All Punctuation Resets Abb 
Tick the “All Punctuation Resets Abb" checkbox if you want to 
expand abbreviations even when you type them straight after a 
punctuation mark. 

Please note: the three “Extras” options may have undesirable side effects in certain exceptional 
circumstances. The bottom line is: if they work for you, turn them on. If you are unhappy with their 
behaviour, just turn them off. They’re entirely optional.  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2.15.4 Autocorrect

TypeIt4Me is primarily concerned with expanding your custom defined abbreviations to longer 
snippets of content. Your abbreviations will of course not be dictionary words themselves, so it 
might not be the best idea for the app to second guess everything you ever type. That said, it 
does offer two flavours of AutoCorrect functionality, accessible under the fourth preferences tab.

Since these days OS X already does a pretty good job of 
spellchecking, both of TypeIt4Me’s AutoCorrect options are 
switched off by default. You can opt to enable just one or 
choose to have both active at the same time; they’re 
complementary to each other.

If you type something that’s not a dictionary word and it’s not a 
defined abbreviation in your active snippet set, either, that’s 
when AutoCorrect kicks in. When both options are enabled, 
TypeIt4Me will first look up your typo in the TidBITS 
AutoCorrect Dictionary (a compendium of commonly misspelt 
words). If it doesn’t find it there, it will ask AppleSpell (the built-
in OS X spell checker provided by Apple) to make a suggestion 
for correction.
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If you place .typeit4me snippet sets in ~/Library/Application Support/TypeIt4Me/AutoCorrect/ they 
will be listed in the popup menu, allowing you to easily change from one to another. By default, 
the menu includes the public domain file made available by TidBITS. 

When you tick the Correct typos with AppleSpell checkbox, a number of extra options will appear 
in the window: No audio feedback, Beep on correcting a typo and Speak the corrected word.

We recommend you turn on audio feedback, 
preferably by having TypeIt4Me speak the 
suggested correction. On selecting either Beep... or 
Speak..., you will be presented with a choice of 
system alerts or system voices. 

You can use the slider to fine tune how 
different the suggested correct word can 
be in relation to your typo. Different users 
will be better served with different settings 
to match the kind of typos they’re prone to 
making. We recommend experimenting 
until you find the setting that suits you.
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To tell TypeIt4Me to leave a specific word alone, add the word to the ignored 
words list. To add a word, click the + button and type the word. To remove a 
word from the list, select it by clicking on it, then click the - button.

…You may not want to keep opening up TypeIt4Me’s AutoCorrect 
preferences every time you need to add a word to ignore. Should that be the 
case, you can define a HotKey to use as a shortcut. The next time 
TypeIt4Me AutoCorrects a word that should have been left alone, press cmd-
z (undo) and while the word you want TypeIt4Me to ignore is highlighted, 
press the HotKey; the word will be added to the ignored words list.

Finally, you can also tell TypeIt4Me to ignore words that are shorter than a 
minimum length that you specify, or those that you type with a capital letter, 
such as proper nouns and acronyms.

Note that AutoCorrect is probably not suited to everyone. It very much depends on the speed and 
style of typing of each individual. If you find it doesn't suit your needs, even after tweaking all the 
settings, just turn it off.  Also note that for AutoCorrect to work, you must select at least one trigger 
(space for example) in the Triggers preferences dialog tab. 
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AutoCorrect in multiple languages 
If you assign a hot key for toggling AutoCorrect on and off and have also enabled more than one 
language in Language & Region System Preferences, TypeIt4Me will first cycle through the top 
three languages in the list when you press the hot key.

For example, if you set F5 as the AutoCorrect hot key and your list of languages 
is like the one pictured here, pressing the hot key will switch from English (U.K.) 
to Français. Pressing it again will switch to Deutsch. One more press on the hot 
key will turn AutoCorrect off. The next press on the hot key will bring back British 
English, starting a new cycle. 

Note that when you make changes to the Preferred Languages list in System 
Preferences, you will need to relaunch TypeIt4Me for the changes to take effect. 

The languages AppleSpell can check are: English, French, Italian, Spanish, 
German, Dutch, Swedish and Portuguese. 
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2.15.5 Apps

The Apps preference tab is where you’ll find the option to assign special behaviours to TypeIt4Me 
when you’re typing in specific apps. For each app listed (added by drag and dropping or by using 
the + button), you can either assign a specific snippet set to be used or you can tell TypeIt4Me not 
to expand abbreviations at all while you’re in that app. To remove an app from this list, just select 
it and click the - button. 

Turn TypeIt4Me off in a specific app
Perhaps you never want TypeIt4Me to expand your abbreviations when you’re 
typing in, say, your password manager app. Just add it to the list using the + 
button. Leave the Special Behaviour field on the default setting, “do not expand”.

Associate a snippet set with a particular app
If you’d like TypeIt4Me to expand abbreviations from one specific snippet set 
when you’re typing in a particular app - i.e. not necessarily the set that’s currently 
active - add the app to the list using the + button, click on the popup menu 
between the Application and 
Special Behaviour columns 
and pick “expand using…” 
then locate the snippet set 
you wish to associate with 
the app in question. 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2.15.6 HotKeys

Rather than constantly move your mouse or trackpad pointer to click on the TypeIt4Me menu, you 
may wish to use quick keyboard shortcuts to initiate certain TypeIt4Me actions. To set these up, 
head to the sixth preferences tab, HotKeys. Here you can define up to six “hot” keys that when 
pressed will invoke the following menu options: 

• Add a snippet

• Edit snippets

• Pause/Resume expansion

• Add a word to the ignored words list
 
• Toggle AutoCorrect on/off  

(Note that if you have more than one language listed in 
International, this hot key will actually cycle through the top three 
listed languages in sequence before reaching the off state.) 

• Go to TypeIt4Me’s Preferences

In the example pictured here, the F1 function key has been 
selected to invoke the “Add a snippet” action. 
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2.15.7 Sync

The seventh preference tab is where you’ll find options for sharing 
and syncing your TypeIt4Me snippets across multiple devices, 
either via the cloud or via a shared local network folder. If you’ve 
installed a cloud syncing service on your Mac, you can enable it 
here to activate the remote / cloud sets pane in the main app 
window. You’ll then be able to save snippet set(s) in your preferred 
cloud or shared folder and use the same set(s) with more than 
one machine. The available sync options are as follows:

• No sync

• iCloud Drive

• Dropbox

• Google Drive
 
• Other…  

(Use this option to specify a shared local network folder.)

On launch, TypeIt4Me scans for Dropbox and Google Drive folders in their default locations on 
your Mac. If you have moved the Dropbox or Google Drive folder from its default installation 
location, then that service will appear greyed out in the sync options list. In this case, TypeIt4Me 
just needs a little help: select the Other… option to locate the folder and you’re good to go. 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2.16 - How to uninstall TypeIt4Me 

Should you ever wish to completely remove TypeIt4Me from your Mac, it’s a relatively 
straightforward process. Just follow these steps to banish all traces of it for good:

• Quit the app (if it’s running).

• Locate the TypeIt4Me app icon in your Applications folder and move it to the trash.

• Locate the com.typeit4me.TypeIt4MeMenu.plist file and move it to the trash.  
(This file is located in the Preferences folder in your user library. In OS X Lion and later Apple 
hides the user library, but you can reveal it by clicking Go in the Finder menu bar and holding 
down the alt key on your keyboard.)

• Empty the trash.

This will completely remove TypeIt4Me and your Mac will forget it was ever installed. If you later 
change your mind and re-install TypeIt4Me you’ll need to re-enter your licence code to prevent it 
regularly popping up messages asking you to register. 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3. Troubleshooting 

A lot of hard work has gone into ensuring your TypeIt4Me experience will be as trouble-free as possible. That 
said, every app ever developed has the odd hiccup and TypeIt4Me is no exception. If you run into trouble, we 
are of course happy to help if we can. First, though, we recommend that you consult this troubleshooting 
section before contacting us; it could help resolve your issue more quickly. What follows is a list of common 
issues you may encounter, together with potential solutions.

3.1 - Common issues and their solutions

3.1.1 TypeIt4Me is not available after you restart or login

If every time you restart or log in to your Mac you find that TypeIt4Me is not running but you’d like 
it to launch automatically, there’s a simple solution. Launch TypeIt4Me and go to Preferences, 
then tick the checkbox at the top that says “Open at Login”. With that option selected, you’ll never 
have to launch TypeIt4Me manually again.
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3.1.2 TypeIt4Me is running but not expanding abbreviations

Sometimes, people report that TypeIt4Me was working normally but then inexplicably stopped 
expanding abbreviations. There are a number of potential causes. If this happens to you, before 
contacting support you may want to try these troubleshooting steps, testing to see if expansion 
works again after each step:

1. Go to System Preferences > Security & Privacy > Accessibility  
and make sure the checkbox next to TypeIt4Me is ticked. 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2. Restart your Mac

3. Check that the abbreviation(s) you have defined does not contain any delimiters (space, etc) 
that you also defined as triggers

4. Try turning all delimiters ON (click on All) in the Triggers section of TypeIt4Me’s Preferences
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5. Try turning all delimiters OFF (click on None) in the Triggers section of Preferences, then quit  
TypeIt4Me, relaunch it and select the TAB and Space delimiters.

6. Restart your Mac again
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7. Go to the Expansion tab of TypeIt4Me’s Preferences and make sure that the first checkbox, 
“Disable keyboard expansion”, is not selected. It may have been ticked by accident.

If you’ve tried all these steps and TypeIt4Me still won’t expand your abbreviations, please email 
support@ettoresoftware.com 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3.1.3 The TypeIt4Me icon is not showing up in the menu bar

If you're not seeing the TypeIt4Me icon in your menubar, don’t panic. There are three possible 
causes, each with a very simple explanation and fix:

• Firstly, TypeIt4Me may not in fact be running, in which case you simply need to relaunch it by 
double clicking it in your Applications folder (or clicking it in the dock if you keep it there).

• Secondly, you may have specified in TypeIt4Me's preferences that the menubar icon should not 
be visible. Long-press on TypeIt4Me in your dock, then navigate to Preferences and make sure 
the ‘Show in menu bar' checkbox at the top is ticked.

• The third possibility is that - though it's still running - TypeIt4Me's icon is being hidden because 
the menubar has become crowded and there are a lot of other items displayed to the right of it. 
Menubar overcrowding can come about when your screen is not wide enough to accommodate all 
your icons as well as all the menu options for the current application in use. MS Word and other 
Office applications have lots of menubar options, so you may find this happens when using them.  
 
Fortunately, there are ways to save space and mitigate this. You could, for example, go into 
'System Preferences' > 'Users & Groups' > 'Login Options' and change the fast user switching 
menu to display as 'Icon' or 'Short name' instead of 'Full name'. Another space saving trick could 
be to change the way the date and time are displayed. If you've tried both of these and there still 
isn't enough space for you to see the TypeIt4Me icon, you could also quit some other less 
frequently used apps that perhaps live in your menubar and then relaunch them so that the 
TypeIt4Me icon moves further over to the right and will be more likely to remain visible at all times. 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4. Glossary 

If you’re familiar with Macs and OS X in general then hopefully the language used to describe 
how TypeIt4Me works won’t sound too much like alien gobbledegook. We’ve tried to keep it as 
simple as possible and limit the amount of jargon for you to decipher. The following is a short list 
of explanations for terms used in a context that’s quite specific to TypeIt4Me.

Text expansion
Text expansion is essentially automatic on-the-fly substitution of 
short typed abbreviations with ‘snippets’ of content. Its name 
derives from the fact that these snippets are usually longer than 
the abbreviations they replace and thus ‘expand’ upon them, 
producing lengthy words, phrases, reams of boilerplate text or 
even pictures.

Text expander
A text expander is a software application that executes text 
expansion, automatically replacing custom defined abbreviations 
on the fly with snippets of text and / or pictures.
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Snippet (aka clipping)
Snippet refers to the full text and / or picture(s) that TypeIt4Me 
will automatically insert in your document when any given 
abbreviation is expanded. It may also refer to the full contents of 
an expansion together with its corresponding abbreviation as a 
defined pairing constituting a single unit, e.g. “there are 15 
snippets in the set” can mean “there are 15 abbreviation / 
snippet pairs in the set”. In earlier versions of TypeIt4Me 
snippets were referred to as “clippings”, because they are items 
of content that are copied to and from the Mac’s clipboard.

Abbreviation (aka shortcut)
This is the text you will type (or pick from a list in the TypeIt4Me 
menu) in order to have a snippet “expanded” (inserted at the 
cursor) in the document or text field in which you’re typing.

Snippet set
In TypeIt4Me a snippet set is a file containing a list of 
abbreviations and their corresponding snippets. In the Mac 
Finder these appear as files with the extension “.typeit4me”. 
They’re stored in a Sets folder in TypeIt4Me’s Application 
Support folder within your User Library.
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Trigger
A trigger is a key on your keyboard that when typed directly after 
a TypeIt4Me abbreviation will cause it to be expanded. There 
are a total of 35 potential trigger keys from which you can 
choose. Most of them are punctuation keys and symbols.

Delimiter
A delimiter is a punctuation or symbol character that can be 
used as a trigger for expanding typed abbreviations.

Sync / syncing
Sync is short for synchronise / synchronisation. Where we refer 
to “sync services” and “sync options”, we mean  services like 
iCloud Drive, Dropbox and Google Drive. Keeping your snippet 
sets in sync across multiple Macs means ensuring that changes 
made to a snippet set on one Mac are automatically available on 
all your other Macs that have been set up to use the same sync 
service and set. 

Page �  of �89 90



5. Support 

This guide is designed to provide you with a solid understanding of how TypeIt4Me works. 
Hopefully you’re already well on your way to saving time and effort that would otherwise be spent 
needlessly grinding away at your keyboard. If there’s anything in this documentation that you find 
unclear, please do get in touch to let us know. We’re also happy to help if you run into problems 
that don’t appear to have been covered here. 

Please bear in mind that we are a very small team, so if you contact us during an exceptionally 
busy period it may sometimes take a little while for us to reply. It’s always a good idea to first 
check the troubleshooting section of this guide (page 81) and the TypeIt4Me Frequently Asked 
Questions section at the Ettore Software website. 9 times out of 10 any problem you’ve 
encountered will be a known issue with a documented solution or workaround.

Frequently Asked Questions
There’s an extensive online FAQ available at http://faq.typeit4me.com

Get help via email
If you have questions that aren’t covered in the FAQ or you’ve run into a problem and can’t find a 
fix anywhere, please send an email to support@ettoresoftware.com
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